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Legal Notices

Copyright 1995 DT Software, Inc.  All rights reserved.  dtSearch and FindPlus are trademarks of DT Software, Inc.  All other brand 
and product names are trademarks of their respective holders.

LICENSE.  This software is licensed to you to use on 1 computer or terminal at a time for the single-user version, and no more than 
5 individual terminals at a time for the LAN 5 concurrent-user version.  You may not rent, lease, lend, sublicense, time-share, 
distribute, sell or assign the license to use this software.  NOR MAY YOU USE THIS SOFTWARE ON MORE COMPUTERS OR 
TERMINALS THAN YOUR LICENSE PERMITS.  You may make backup copies of the software strictly for your own archival 
purposes.  YOU MAY NOT OTHERWISE COPY OR TRANSFER THIS SOFTWARE.  IN NO EVENT, MAY YOU OR ANY OTHER 
PARTY MODIFY, ADAPT, TRANSLATE, REVERSE ENGINEER, DECOMPILE, DISASSEMBLE, OR CREATE DERIVATIVE 
WORKS BASED ON THIS SOFTWARE.

EVALUATION VERSION.  If this is an evaluation copy of dtSearch, you may use it for up to 60 days and only for evaluation 
purposes.  

U.S. Government Information.  Use, duplication, or disclosure by the U.S. Government of the computer software and 
documentation in this package shall be subject to the restricted rights applicable to commercial computer software as set forth in 
subdivision (b)(3)(ii) of the Rights in Technical Data and Computer Software clause at 252.227-7013 (DFARS 52.227-7013).  The 
contractor/manufacturer is DT Software, Inc., 2101 Crystal Plaza Arcade, Suite 231, Arlington, VA 22202.

Limited Warranty.  DT Software warrants the physical diskettes and physical documentation provided to be free of defects in 
materials and workmanship for a period of ninety days from the date of purchase.  If DT Software receives notification within the 
warranty period of defects in the physical diskettes or physical documentation, and such notification is determined by DT Software to 
be correct, DT Software will replace the defective diskettes or documentation.

Disclaimer of Additional Warranty.  Except as provided in the above Limited Warranty, dtSearch is provided AS IS.  DT Software 
makes NO OTHER WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY AND/OR FITNESS FOR A PARTICULAR PURPOSE.

Limitation of Liability.  To the extent permitted by law, the total liability of DT Software for any claim or damage arising out of the 
use of the licensed program or otherwise related to this license shall be limited to replacement of defective diskette(s) or 
documentation.  IN NO EVENT SHALL DT SOFTWARE BE LIABLE FOR ADDITIONAL DAMAGES, including lost profits, lost 
savings or other incidental or consequential damages arising out of the use of or inability to use the licensed program, even if DT 
Software has been advised of the possibility of such damages.  IN NO EVENT WILL DT SOFTWARE’S LIABILITY FOR ANY 
DAMAGES EVER EXCEED THE LOWER OF SUGGESTED LIST PRICE OR ACTUAL PRICE PAID FOR THE SOFTWARE.

Unisys LZW Notice.  LZW decompression is licensed from Unisys Corporation under U.S. Patent No. 4,558,302 and foreign 
counterparts.  Unisys requires the following license terms:  "This software is restricted to use only on personal computers and 
workstations for the purpose of reading and/or writing GIF-LZW and TIFF-LZW images.  A separate purchase of this software is 
required for each additional personal computer or workstation which will use the software, either directly or via a server.  Customer 
may not modify or copy this software or make or develop any derivatives thereof, except that one copy may be made solely for 
backup or archival purposes."



dtSearch Quick Start 

dtSearch can search megabytes of text in a second.  It does this by building an index that stores 
the location of words in your files.  An index does not store the text of documents, so to view 
retrieved documents you will still need to keep the documents accessible.

Indexing Documents

1. Choose Create Index (Basic) from the Index menu.

2. Enter a name for the index and click OK.

3. dtSearch will ask if you want to add documents to the index.  Click Yes and the Update 
Index dialog box will appear.

4. In the Update Index dialog box, click Select to select the directories you want to index.  
When you finish selecting directories, click OK.  

5. Click OK to begin adding documents to your index. 

Note 1: Disk Space.  To build the index, dtSearch needs free space on the drive containing the 
index at least equal to the size of the documents to be indexed.  (This is because dtSearch 
creates temporary files during indexing.)  Once complete, an index is usually about a fourth the 
size of the original documents, though this can vary depending on the number and type of 
documents.  In general, the more documents in an index, the smaller the index will be as a 
percentage of the documents.   

Note 2: File Formats.  dtSearch automatically recognizes major word processor files, database 
files (32-bit version through ODBC), ANSI text files, ZIP files, and HTML files.  For a complete 
list of the file formats that dtSearch supports, see Supported File Types in the on-line help.

Note 3: EXE and other Program Files.  By default, dtSearch will index and search everything 
in a selected directory.  To avoid indexing files that are not documents, use filename filters in the 
Update Index dialog box.

Searching using an Index

1. Click Search on the button bar (or choose Index Search from the Search menu).  The Index 
Search dialog box will appear.  At the top of the dialog box is a box that can display any of 
the following search tools:

         Word List A scrolling list of the words in the index you have selected. 
Next to each word is a number, which is the number of times the 
word occurs in the index. As you type in a search request, the list 
will scroll to the word you are typing. 

If you have selected more than one index to 
be searched, the highlighted index will be the one listed.  To 
change the index displayed in the Word List, click on the index you 
want to see in the Indexes to Search box. 

         Hints The basics of creating search requests. 



         History A list of your most recent search requests.  Next to 
each request is a pair of numbers, like "35/283," which tells you 
the number of files and hits that the request found.

         Macros A list of the macros you have created.

To select one of the tools, use the buttons at the top of the search dialog box.  To insert a 
word, previous search request or macro into a search request, click on the item to highlight it 
and click the Insert button.

2. Click the Select button to select indexes to search.

3. Enter a search request in the space provided.  There are two basic types of search 
requests:

A natural language search request consists of an unstructured natural language or "plain 
English" query.  In a natural language search request, words such as AND and OR are 
disregarded.  A natural language search can rank retrieved files from most to least 
relevant according to the density and rarity of matching words in your documents.

A structured search request consists of a group of words, phrases or macros linked by 
search connectors such as AND and OR to precisely indicate the relationship between 
them.

To enter a natural language search request, click Natural language under Search features 
and type in a plain English search request:  Get me Sam's memo on the 1994 takeover 
of CorpX.  

To enter a structured search request, enter words or phrases linked by connectors.  

              AND both words must be present 
              OR  at least one of the words must be present 
              NOT the next word must not be present
              W/5 the words must occur not more than 5 words apart 

(you can also use W/10, W/20, etc.) 
              *     matches any number of letters
              ?     matches any single letter 

Examples: 
apple and pear 
*apple w/6 pear 
apple sauce w/27 grape ju?ce 
apple and (pear w/5 bana*a) 
apple and not pear
not pear 



To have dtSearch enter the connectors for you, click the Compose Request button to 
access the Compose Search Request dialog box.  In the Compose Search Request dialog 
box, you can enter the words or phrases you want to search for and click on connector 
buttons to describe how the words are related. 

4. Select Search Features to use in the search.

Stemming searches other grammatical forms of the words in your search request.  For 
example, with stemming enabled a search for apply would also find applies.

Phonic searching finds words that sound similar to words in your request, like Smith 
and Smythe.

Fuzzy searching sifts through scanning and typographical errors.  Fuzziness adjusts 
from 1 to 10 depending on the degree of misspellings.  (Try starting with 3.)

To see how stemming, phonic searching, fuzzy searching or wildcards will affect your 
search, click the Lookup button.

5. Click OK to start the search.

Viewing Search Results

1. After a search is complete, a dialog box will appear listing options for sorting search results 
(file name, file date, or number of hits).  Pick one of the options, click OK and a Search 
Results window will appear.

2. To select a document to view from the Search Results window, double-click on it or move 
the cursor to it and press ENTER.  The document will appear in a new window overlaying 
Search Results. 

3. To jump to the next hit in a document window, click Next Hit on the button bar or press 
SPACEBAR.

4. To search for text in a retrieved document, click the Find Text button in the button bar, enter 
the text you want to find, and click OK.

5. To switch between a document window and search results, press TAB.  To close a document 
window, press ESCAPE.

6. For a menu of all options you can use in a document window or Search Results, click the 
right mouse button anywhere in the window.

7. Click the Launch button to open a document in the application associated with it.  For 
example, an HTML document would be launched in your web browser.  See "Launching 
Applications" in the manual or on-line help for more information on associating documents 
and applications.

8. Click the Image button to view an image associated with a document file.  See "Linking 
Images and Documents" in the manual or on-line help for more information on associating 
documents and images.



9. Hypertext links in HTML documents will appear in dtSearch in green and underlined.  To 
follow a hypertext link, double-click on it.  A link may connect to another document, an image 
file, or a document on the internet, in which case dtSearch will launch your web browser to 
access the document.



Copying Retrieved Text

To copy a block of text from a document to the Windows clipboard or to a file, mark the text 
(click and drag with the mouse) and click the Copy button in the button bar.

To copy an entire file, choose Copy File in the Edit menu while you are viewing the file.  If a file 
is stored in a ZIP archive, Copy File will extract it from the archive.

To copy multiple files from Search Results, press SPACEBAR to mark the documents you want 
to copy (a "*" will appear next to each selected document) and then choose Copy File.  You can 
also use SPACEBAR to mark multiple files to print, delete, or include in a Search Report (see 
below).

Create a Quick Summary of Your Search Results

An easy way to see all hits in all retrieved documents is to build a Search Report.  A Search 
Report shows all hits along with the amount of context that you request.  It also contains 
hypertext links to the hits in your files.

1. Choose Search Report from the Search menu.  The Generate Search Report dialog box 
will appear.

2. Enter the number of words of context that you want dtSearch to include in your Search 
Report and click OK to generate the report.

3. In the Search Report, double-click on the highlighted hypertext links to jump to the location 
of hits in your documents.  Search Reports contain two types of hypertext links:  highlighted 
page and paragraph numbers like [Page 4 Paragraph 22] which take you right to the 
location of a hit, and highlighted document names, which take you to the top of the 
document.

Scanning

If you have TextBridge® OCR by Xerox,® you can scan documents from within dtSearch.  

1. Install TextBridge if it is not already installed and test it by scanning a document using 
TextBridge directly.  Once you have TextBridge set up correctly, dtSearch will automatically 
recognize your settings when you scan from within dtSearch.

2. In dtSearch, choose Scan from the File menu to access the Scan dialog box.  

3. Under Document to create, enter the name of the file you want to create and select the file 
type of the document you want to create.  

4. Check Save image of document if you want to be able to view the document as an image.

5. Click the Scan button to start scanning the document.  

6. After you have scanned a document, it will appear in the Scanned Documents list in the 
dialog box.  To index the documents listed, click the Index button.

7. If you checked Save image of document when you scanned a document, you can click the 
Image button in the button bar when you are viewing the document to see the scanned 



image of the document.



Using dtSearch on a Network 

Installing dtSearch in a Shared Directory 

1. Install dtSearch in a directory that each user will have read-only access to.  

2. Make each of the dtSearch program files read-only.  (This step prevents sharing violations 
on some networks.)

3.  Set up private directories.  Each user will need a private, writeable directory that dtSearch 
can use for temporary files and to store the user's setup files.  This directory cannot be 
shared.  

The easiest way to set this up is for each user to use a directory on the user's own local 
hard disk (such as C:\DTSEARCH) as a private dtSearch directory.  Have each user run 
dtSearch using the /DIR command-line switch to designate a private directory, like this:

DTSWIN /DIR C:\DTSEARCH

Alternatively, if you want private directories to reside on the network rather than on each 
user’s local hard drive, and if your network creates an environment variable containing each 
user's name (%USER% or %USERNAME%), you can use that environment variable with 
/DIR.  For example, to give each user a private directory on the shared H: drive:

DTSWIN /DIR H:\%USER%\DTSEARCH 

An alternative to the /DIR command-line switch is to designate a private dtSearch directory 
by setting the %DTSDIR% environment variable in each user's AUTOEXEC.BAT file, like 
this:

SET DTSDIR=C:\DTSEARCH 

Shared Setup Files

dtSearch looks for setup files in each user's private directory first and, if it does not find setup 
files there, checks the shared dtSearch directory.  When dtSearch saves a setup file, it writes 
the file to the user's private directory. This makes it easy to set up all users with a common initial 
configuration that they can then customize to suit individual preferences.  To set up the initial 
configuration, do the following: 

1. Run dtSearch directly from the shared network directory without the /DIR option, so all setup 
files will be stored in that directory. 

2. Set up the configuration you want.

3. Exit dtSearch. 

4. Make the new setup files read-only.

Shared Indexes and Concurrent Indexing and Searching

dtSearch supports multiuser access to indexes stored on networks.
Drive Mapping.  To avoid possible drive mapping problems, build an index on the same drive 



as the documents it indexes.  This prevents drive mapping problems since dtSearch, by default, 
uses relative rather than absolute paths in indexes.  (See “Relative Paths” in the manual or on-
line help.)

Index Libraries.   A user's index library is a file that lists the indexes a user can search or 
update.  On a network, index libraries can be either shared or private.  If all users share a 
common library, then each user will automatically be able to search indexes that are added to 
the library.  If a user has a private index library, the user can use Recognize Index to add 
shared network indexes to the user's index library.

If a user is using a shared index library that the user has read-only access to and the user 
creates an index, dtSearch will be unable to add the index to the shared library and will create a 
private index library for the user.

Read/Write Privileges.  Write and read access to shared indexes is controlled completely by 
the network's access permission settings.  If an index is stored on a network drive, any user who 
has write access to the directory containing the index will be able to update the index in 
dtSearch.  Any user who has read access to the index will be able to search the index or 
perform other functions (such as Verify Index and Copy Index) that do not require write access. 

Concurrent Access.  When a user is updating an index, other users will be able to search but 
not update the index.  When a user is compressing an index, other users will be unable to 
search or update the index.

User Names (Optional)

If a network supports use of an environment variable such as %USER% or %USERNAME% to 
identify users, then users can enter that environment variable in User Name in Preferences in 
the Options menu.   

Network Troubleshooting

After a search, dtSearch displays search results correctly but users cannot view retrieved 
documents.

1. Most commonly, this is caused by drive mapping problems.  For example, for the user who 
indexed the documents, the documents were in C:\DOCS, but for the user doing a search, 
the documents were in K:\DOCS.  These problems are especially common on peer-to-peer 
networks, because each user sees each drive differently.  To avoid drive mapping problems, 
build indexes on the same drive as the indexed documents.

2. Make sure all users have read access to the directory containing the documents.

An index is built in a shared directory but it does not appear in a user’s list of indexes.

Have the user use Recognize Index in the Index menu to add the index to the user's index 
library.

When one user is running dtSearch from a shared directory and another user tries to run 
dtSearch, the second user gets a “sharing violation” message. 

1. Make sure every user is using a separate private directory.
2. On some networks, a file cannot be shared unless it is read-only.  Use Explorer (in Windows 

95) or Windows’ File Manager (in Windows 3.x and Windows NT) to make every file in the 



shared dtSearch directory read-only.


